March 15, 2018

            FY18 Career Ed FTE and CTE detail to SFPR reconciliation
There is not a required way to use the FTE detail report.  This is one suggestion on how to reconcile it to your SFPR. Please use as best meets your need.  CTE reconciliation is still a work in progress and when it comes out will be a separate set of instructions.
Phase One:
This document is a work in progress.  When updates occur to the FTE Detail these directions will change.  
[bookmark: _GoBack]
Open your foundation funding report on the ODE website.  Choose the period you want to reconcile such as Oct.  Choose your district and click on three reports; 1) JVS SFPR Payment Report Detail 2) Open Enrollment 3) Other Adjustments.  
Open your reconciliation workbook.  It should open to the SFPR tab, if not, click on the SFPR tab. In cell B4 enter your IRN number. Make sure your District name shows up in cell C4!!  Go to cell O4 and put the Month for the period you are reconciling. Enter the FTE’s from the ODE Foundation “Detail” report for cells O6, O8 to O13, O15 to O19, O21 to O23, and O25.  
Go to the foundation funding report.  Copy the Open Enrollment Data into the reconciliation workbook tab OE.  Copy into cell A1 and do a text to column.  Click on Data, Text to Columns, choose fixed width and then go through the steps.  You may have to move the line separators around.  The end result should look like below:
[image: ]
Sort Column “Type”, “Z-A” sort order.  The CT’s will be at the bottom.  Add three empty rows between the bottom JVSD and the first CT code.  Then copy the heading in row one directly above the first row of the CTs.  That section should look like this once you have finished copying.
[image: ]
Next go to cell A3 and sort the IRN smallest to largest.  Copy the IRNs from this group into cell L1.  Go to the Data tab and choose “Remove Duplicates”. A message box will pop and tell you “XX duplicate values found and removed; Y unique values remain”.  The results will look like below.
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Obviously everyone will have different numbers of duplicate values and unique values.  
You will then copy the unique IRN values to the SFPR tab placing them beginning in cell B31 reserved for Open Enrolled In IRNs. Before you copy please make sure you have enough rows to accommodate the data you are moving.  If there are not enough rows simply add the number that you need and copy the formulas sown that you need.    
Next you will need to subtotal the open enrollment FTEs by IRN on the Open Enrollment tab.  Place your cursor in cell A4.  Click on the Data tab and choose Subtotal on the far right.  A box will open that should look like this:
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Make sure that you choose the “Sum” function.  The result should look like this:
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You now need to enter the ADM/FTE into column O of the SFPR tab starting in cell O31.  The easiest way to do this is by clicking on box 2 in the left hand corner next to column A and row 1.  This will give you a total for each IRN and this should make it easier to copy each IRN total by holding the control key down while you copy each individual cell over to the SFPR tab. 
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The next step is “Other Adjustments”.  The “Other Adjustments” is your special ed and vocational contract students.  Some of you may not have this.  If you do, you will want to copy that data over into the “Other” tab just like you did with the open enrollment data.  Go to the data tab, click on text to columns, go through the steps and your result will look like this.
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Sort the data by TYPE, Z to A.  This will be your result.
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Delete the rows with no STATUS, etc.  Insert three rows between the last SE or OTH, TYPE code.   Copy the first row label above the first CTA row.  Sort column A, A to Z.  Insert a new column in A and label it IRN.  You will need to look up the IRN numbers in the IRN tab and enter them. You will need to sort this data a second time by IRN number.  Copy the results to column J, click on data, then click on remove duplicates.  Copy the unique IRN numbers to the first row under “VOED-Other In” beneath the “Other adjustments” in the SFPR tab.  Copy the formulas down as far as you need.  Go back to the Other tab and subtotal by IRN.  Copy the FTE total by district to the SFPR tab, column O.
Phase Two:
Open your FTE Detail Report.  It should have one tab, and in that tab columns A to AL.  Stop. Was the last column AL.  Columns were increased to AL on or around May 12, 2017.  If the last column is not AL the reconciliation may not work.  It means that the detail report has changed and the reconciliation may need to be modified.

Place your cursor in cell B3, click on Sort and Filter and choose filter.  Click on the “VIEW” menu at the top of the spreadsheet.  Click on Freeze panes and choose “Freeze Top Row”.  Now scroll to the very last row of this worksheet.  Let’s say there are 4,140 rows.  Go to cell column Q row 4,142 and put in the following formula =subtotal(9,Q2:Q4140).  You can now filter any criteria you want and the number of Adj FTE’s for that criteria will subtotal.  You are now going to copy the FTE detail report into the “FTE Detail” tab in the reconciliation workbook.  Once you do that save the original FTE Detail report.  I would recommend saving it in an FTE detail report folder and name it the date that you created it.

The reconciliation workbook should have populated with the FTE details.  Variances between the FTE detail and the SFPR should be showing up in column P.  You may be wondering why there are ten columns between D and M and some have numbers and some don’t.  If you hover your mouse over D5 there is a comment in that cell that will read “Regular/Other District and Regular JVSD”.  Each cell from D5 to M5 has a description of the type of student being captured in that column.  In most cases the columns with the highest FTE count will be RGJV.
Let’s look at the FTE detail report to see what column combinations created the FTEs.  Currently there are 38 columns from A to AL.  Of those 38 I am using some combination of twelve of them to populate the reconciliation spreadsheet.  Those twelve are:
[image: ]
Each cell being calculated at the minimum looks at the IRN in cell B4 of the SFPR tab to find a match in column A, I, or S of the FTE Detail tab.  It then matches the Fund pattern code in row 5 of the SFPR to column M in the FTE Detail.  If there is a match it adds the FTE amount in Column Q of the FTE Detail.  
  
Some cell calculations will only include FTE INCL CODE FULL or PART in column AD of the FTE detail, some will include both.  If a cell calculation is only looking at FULL or PART only, it will reference column AD in the calculation.  
Your special education (SFPR b1 – b6), Limited English Proficient “LEP” SFPR d1 – d3), and economically disadvantaged (SFPR e1 and e2), funding lines look at columns AA (SPECED CAT CODE), AB(ECON DISADV FLAG), and AC (LEP CODE), in the FTE Detail tab respectively.
CTE Reconciliation
The CTE detail can be found in the data collector.  For FY18 the manifest code is 2018L1S2R.  I recommend saving this spreadsheet separately from the reconciliation.  You will find 42 columns, A to AP, of data when you download this spreadsheet.  The number of rows will vary by District.  You will have a separate line for each career ed class a student takes.  
Go to cell C2 and then choose the View menu.  Click on Freeze Panes.  Click on the first choice, Freeze Panes.  Next choose the Home menu, and click on Sort and Filter, then click filter.  Click on the filter drop down box in column P, local classroom code, and click sort “A to Z”.  You now have all the classes sequentially.  
Add another tab to the workbook.  Label it local classroom code.  Copy all of the data from column P, Local Classroom Code, into the tab you just named.  While the data is still highlighted go to the Data menu and click on Remove Duplicates.  Remove the duplicates. You will be left with a single entry for each class.   Most traditional districts won’t have more than 50 rows of classes, if you are a JVSD or a large urban you may have over 1,000 rows.
Now copy all the information from the original CTE download into the CTE detail tab of the reconciliation spreadsheet.  Next, copy all of the local class codes you from the local classroom code tab you just created into column A of the CTE analysis tab on the reconciliation spreadsheet
In the CTE analysis tab copy the formula from column B row 3, to column Y row 3 as far down as you need for the classes you have.  Go to cell AE3 and enter your state share index.  You now have detailed information on each class that was offered.  You have how many CTEs populated your SFPR, categories c1 through c5, in column F, your “open enrolled in” CTEs in column G, and your “other” CTEs in column H by class.  You can also see how much funding a class generated in column J as well as how many students were in the class in column K.  Column M through W shows how many students were in the different fund pattern codes educated elsewhere. 
Put your cursor in cell B3, click on view, freeze panes, and then click freeze panes.  You may also want to put subtotals at the bottom of selected columns.
Enter the FTEs from c1-c5 from the SFPR detail worksheet report to cells AE12 down to AE16 of the CTE analysis tab.  In column AF the difference between the CTE detail and the SFPR will show.  Next enter the open enrollment CTEs from the JVS open enrollment report into cells AE23 – AE27.  They are at the bottom of the open enrollment report and look like the example below.  
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The “Other” CTEs can be found on the Other Adjustments report.  You should have already copied this data into the “other” tab on the reconciliation spreadsheet when you were doing the FTE reconciliation.  If you have not subtotaled them, please do so now.  Enter those CTEs in cells AE32 – AE36.
In Seat
This tab was created for traditional districts because their detail report included students being educated elsewhere.  This is not the case for a career tech center.  It was included for career tech schools so that you could see your student counts by grade level and special education disability.  It includes all students being educated by you.
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IRN

RESIDENT/ATTENDING DISTRICT COUNTY TYPE ADM/FTEAMOUNT

44552

NORTON CITY S.D.      /Chippewa SUMMIT JVSD 0.36          $2,124.00

44552 Total

0.36          $2,124.00

45823

HILLSDALE LOCAL S.D. ASHLAND JVSE 1.00          $5,900.00

45823

HILLSDALE LOCAL S.D.  /Triway ASHLAND JVSE 1.00          $5,900.00

45823

HILLSDALE LOCAL S.D. ASHLAND JVSD 1.00          $5,900.00

45823

HILLSDALE LOCAL S.D.  /Northwestern ASHLAND JVSD 1.00          $5,900.00

45823 Total

4.00          $23,600.00

45831

MAPLETON LOCAL S.D. ASHLAND JVSE 1.00          $5,900.00

45831

MAPLETON LOCAL S.D.   /Northwestern ASHLAND JVSD 2.00          $11,800.00

45831 Total

3.00          $17,700.00

47696

WEST HOLMES LOCAL S.D./Northwestern HOLMES JVSE 0.47          $2,773.00

47696

WEST HOLMES LOCAL S.D./Southeast HOLMES JVSD 1.00          $5,900.00

47696 Total

1.47          $8,673.00
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IRN

RESIDENT/ATTENDING DISTRICT COUNTY TYPE ADM/FTEAMOUNT

43505 Total

0.14          $826.00

44297 Total

0.98          $5,782.00

44438 Total

1.00          $5,900.00

44552 Total

0.36          $2,124.00

45823 Total

4.00          $23,600.00

45831 Total

3.00          $17,700.00

47696 Total

1.47          $8,673.00

48462 Total

2.50          $14,750.00

48488 Total

1.60          $9,440.00

49841 Total

0.56          $3,304.00

49858 Total

1.00          $5,900.00

50575 Total

1.00          $5,900.00

Grand Total

17.61        $103,899.00


image7.emf
RESIDENT/ATTENDING DISTRICT

COUNTY STATUS TYPE FTE AMOUNT

ORRVILLE CITY S.D.

WAYNE VEC CTA2 0.04 $189.28

/Liberty Prep School

Wayne

ORRVILLE CITY S.D.

WAYNE VEC OTH2 0.05 $295.00

/Liberty Prep School

Wayne

ORRVILLE CITY S.D.

WAYNE VEC CTA1 0.33 $1,647.36

/Electronic Classrm Of

Franklin

ORRVILLE CITY S.D.

WAYNE VEC OTH2 0.4 $2,360.00

/Electronic Classrm Of

Franklin

WOOSTER CITY S.D.

WAYNE VEC CTA1 0.64 $3,194.88

/Liberty Prep School

Wayne

WOOSTER CITY S.D.

WAYNE VEC CTA2 0.26 $1,230.32

/Liberty Prep School

Wayne

WOOSTER CITY S.D.

WAYNE VEC OTH2 1.11 $6,549.00

/Liberty Prep School

Wayne

WOOSTER CITY S.D.

WAYNE VEC SE22 0.22 $2,161.72

/Liberty Prep School

Wayne

WOOSTER CITY S.D.

WAYNE VEC CTA1 0.54 $2,695.68
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RESIDENT/ATTENDING DISTRICT

COUNTY STATUS TYPE FTE AMOUNT

WOOSTER CITY S.D.

WAYNE VEC SE22 0.22 $2,161.72

WOOSTER CITY S.D.

WAYNE VEC SE22 0.1 $982.60

NORTHWESTERN LOCAL S.D.

WAYNE VEC SE22 0.5 $4,913.00

SOUTHEAST LOCAL S.D.

WAYNE VEC SE22 0.5 $4,913.00

ORRVILLE CITY S.D.

WAYNE VEC CTA2 0.04 $189.28

WOOSTER CITY S.D.

WAYNE VEC CTA2 0.26 $1,230.32

CHIPPEWA LOCAL S.D.

WAYNE VEC CTA2 0.01 $47.32

NORTHWESTERN LOCAL S.D.

WAYNE VEC CTA2 0.42 $1,987.44

ORRVILLE CITY S.D.

WAYNE VEC CTA1 0.33 $1,647.36

WOOSTER CITY S.D.

WAYNE VEC CTA1 0.64 $3,194.88

NORWAYNE LOCAL S.D.

WAYNE VEC CTA1 0.33 $1,647.36

NORTHWESTERN LOCAL S.D.

WAYNE VEC CTA1 0.45 $2,246.40

SOUTHEAST LOCAL S.D.

WAYNE VEC CTA1 0.42 $2,096.64

TRIWAY LOCAL S.D.

WAYNE VEC CTA1 1.97 $9,834.24

/Liberty Prep School

Wayne

/Liberty Prep School

Wayne

/Electronic Classrm Of

Franklin

/Electronic Classrm Of

Franklin

/Liberty Prep School

Wayne

/Liberty Prep School

Wayne

/Liberty Prep School

Wayne
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Column Description Explanation/Example

A RPT DEST IRN District receiving the report

I LEA IRN School or District the student is educated in

M FTE FUND PTTRN CODE RGJV, OPDD, COMM, etc

Q ADJSTD FTE Funded FTE .01 to 1.0

R

ADJSTD SPECED CAT FTE

Funded Special Ed Category

S LEGAL DIST OF RES IRN Where party responsible for tuition resides

Y STATE EQUIV GRADE LEVEL CODE KG, 01, 02, etc

AA SPECED CAT CODE Special Ed Funding Categories 1 to 6

AB ECON DISADV FLAG Y or N

AC LEP CODE L, M, N, S, Y

AD FTE INCL CODE Full, Part, None

AI LEA TYPE Regular, STEM, B&M COMM, E-School, CBDD
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TOTALS

CTA1 24.21000   125,698.32         

CTA2 11.08000   54,524.68           

CTA3 1.86000     3,338.70              

CTA4 22.48000   34,282.00           

CTA5 4.64000     6,069.12              

JVSD 58.66000   351,960.00         

JVSE 11.56000   69,360.00           
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IRN

RESIDENT/ATTENDING DISTRICT COUNTY TYPE ADM/FTEAMOUNT

43505

ASHLAND CITY S.D.     /Northwestern ASHLAND CTA2 0.02 $94.64

43505

ASHLAND CITY S.D.     /Northwestern ASHLAND CTA4 0.06 $87.96

43505

ASHLAND CITY S.D.     /Northwestern ASHLAND JVSD 0.14 $826.00

44297

MANSFIELD CITY S.D.   /Orrville RICHLANDCTA1 0.41 $2,046.72

44297

MANSFIELD CITY S.D.   /Orrville RICHLANDCTA4 0.41 $601.06

44297

MANSFIELD CITY S.D.   /Orrville RICHLANDJVSE 0.98 $5,782.00

44438

NAPOLEON AREA CITY S.D/Northwestern HENRY CTA2 0.42 $1,987.44

44438

NAPOLEON AREA CITY S.D/Northwestern HENRY CTA4 0.42 $615.72

44438

NAPOLEON AREA CITY S.D/Northwestern HENRY JVSD 1 $5,900.00

44552

NORTON CITY S.D.      /Chippewa SUMMIT CTA2 0.15 $709.80
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49858

JACKSON LOCAL S.D. STARK JVSD 1 $5,900.00

50575

NORTHWESTERN LOCAL S.D/Mapleton WAYNE JVSD 1 $5,900.00

IRN

RESIDENT/ATTENDING DISTRICT COUNTY TYPE ADM/FTEAMOUNT

43505

ASHLAND CITY S.D.     /Northwestern ASHLAND CTA4 0.06 $87.96

44297

MANSFIELD CITY S.D.   /Orrville RICHLANDCTA4 0.41 $601.06

44438

NAPOLEON AREA CITY S.D/Northwestern HENRY CTA4 0.42 $615.72
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"Before" "After"

L L

1 IRN IRN

2 43497 43497

3 43497 43539

4 43497 44503

5 43497 48355

6 43539 48389

7 44503 49247

8 48355 49882

9 48389 49890

10

48389

11

48389

12

48389

13

48389

14

48389

15

49247

16

49882

17

49882

18

49882

19

49882

20

49882

21

49882

22

49890


